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The contents of this primer can also be found in the ARC
Plus Touch version 5 Instruction Manual. We are including it
here for the benefit of users of earlier releases. While written
specifically for version 5, the concepts apply to earlier
versions. For older versions, check with your specific manual
to determine if a feature is available.

Copyright © 2008-2014 Burk Technology, Inc. All rights reserved.
Information in this manual is subject to change without notice
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MACROS
The ARC Plus features on-board macros for automatic responses to conditions at the remote site, scheduled
activities based on time-of-day, or calendar-based routines that reference pre-configured calendar times.

MACRO PRIMER
Macros consist of a series of individual lines that generally act in sequence. There are only three types of macro
lines: branching, actions and IF statements.

BRANCHING
Branching controls the order in which macro instructions are executed. Without branching, we would merely have
a list of steps to follow which would play back much like a recording. With branching, it is possible to make the
macro behave differently under different conditions.
There is only one branching instruction in the macro language, goto, but it appears in two different forms. On a
line by itself, goto is used to branch to a different line like this: Goto line 1.
It also appears as part of an IF statement: If (something) = (something else) goto line 4.
Branching also allows looping in the macro. This is useful for constantly checking on something or performing an
action until some result is achieved. To perform a loop, put a goto on the line following the steps to be looped
followed by the line number of the first action. If there are no if statements branching out of the loop, it is an
infinite loop. If the action needs to end when a value is reached, include an If statement in the loop which includes
a goto to a line outside the loop (such as an end statement at the end of the program).

ACTIONS
Actions include physical things like
Raise "TX-A RF ON" on site "BURK-FM" for 00:00:01

and more virtual things like Decrement memory 8 or

You do not have to type these
lines into the macro!
The Macro Editor is “point and
shoot” so there is little to
remember and no such thing as
a syntax error.

Wait for 00:00:01.

Actions also include “Set” functions like
Set Test1 on BURK-FM = 100 or
Set high critical of "TX-A FWD" on "BURK-FM" to 105.

For a complete set of actions Click or turn to MACRO EXPRESSIONS.

IF STATEMENTS
When a macro is started, it executes lines sequentially unless it is redirected by a goto. Each If statement has a
comparison which is evaluated for true or false. A goto is included in every If statement, but it is conditional on
the results of the comparison. If the comparison is true, the IF statement will branch the macro to another line. If
not, the macro will simply continue on the next line.
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Consider this scenario: We always want to make sure the Dummy Load pump or fan is turned on before putting
the transmitter into it. Our “Test TXA” routine might contain something like this:
1
2
3
4

:
:
:
:

If status of "LOAD OFF / LOAD ON" on site "BURK-FM" = "LOAD ON", goto line 4
Raise "LOAD ON" on site "BURK-FM" for [default]
Wait for 00:00:30
Raise "TX-A RF ON" on site "BURK-FM" for [default]

At the start of this macro, if the load is already running, we’ll go directly to starting the transmitter. If the load isn’t
on, we’ll turn it on and wait 30 seconds before starting the transmitter. (Tube filaments could be done the same
way.)
Looking at this macro line by line, the first line is obviously an IF statement. The comparison we are evaluating is a
status input being compared to a literal value. The status input is labeled "LOAD OFF / LOAD ON" and the
literal we are comparing with is "LOAD ON". If the expression evaluates to true, we are branching to line 4. In
plain English, “If the load is on, then skip to line 4, else continue on line 2.”
Line 2 doesn’t get executed unless the branch from line 1 is not taken. That is, if the test for the load being on
fails, we don’t take the branch to line 4 but rather continue on sequentially, executing Line 2 which is a Raise
command. This line contains the channel and site information as well as the duration of the command.
After the Raise command the macro will wait for 30 seconds.
Finally we get to line 4 and turn on the transmitter with another Raise command.
There are many types of IF statements and they are listed in MACRO EXPRESSIONS.
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EXAMPLES
Here are a few examples to get you going. You will want to look through MACRO EXPRESSIONS to see how some
of the statements work.

RUN ON TUESDAY
This is a simple macro that makes sure our coffee is ready when we get to the site for weekly maintenance. The
macro is scheduled for our normal maintenance time, but will only start the coffee on Tuesday, our maintenance
day. Check out MACRO SCHEDULE to see how to set the time.

1

2

3

If day <> Tuesday, goto line 3
Raise "Start Coffee" on site "BURK-FM" for
[default]
End macro

MUTE METERS
In this example, all we want to do is grey out the meters on the A transmitter. This macro could be called from
another macro that put the B transmitter on the air. You would also need unmute macros for each transmitter.

1

Set meter "TX-A FWD" on "BURK-FM" to muted

2

Set meter "TX-A RFL" on "BURK-FM" to muted

3

Set meter "TX-A PAV" on "BURK-FM" to muted

4

Set meter "TX-A PAI" on "BURK-FM" to muted

5

End macro
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ALARM COUNT
This macro nags you every hour until you respond to the fact that there a 10 or more alarms. This could be set to
run at startup so it is always on. During maintenance you could stop it manually.

1

If alarm count on site "BURK-FM" < 10, goto line 1

2

Send email message “more than 10 alarms!” to email
list "Chief"

3

Wait for 01:00:00

4

Goto line 1

TRANSMITTER START SEQUENCE
Here is a tube transmitter startup that skips the filament turn on and delay if filaments are already on.

1

If status of "TX-A FIL ON / TX-A TX-A FIL OFF" on
site "BURK-FM" = "TX-A FIL ON", goto line 4

2

Raise "TX-A
[default]

3

FIL ON" on site "BURK-FM" for

Wait for 00:05:00

4

Raise "TX-A
[default]

5

End macro

RF ON" on site "BURK-FM" for
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SWITCH TRANSMITTERS
This macro toggles to the other transmitter, no matter which one is on. It also leaves a trail of messages in the
event log so it is easy to see what happened if the transfer is not successful.
1

2

Turn macro "AUTO ON" off
If status of "TX-B ON ANTENNA / TX-A ON ANTENNA" on site
"BURK-FM" = "TX-B ON ANTENNA", goto line 9

3

4

Message "ATTEMPT XFER TO B"
If status of "TX-B FAULT / TX-B OK" on site "BURK-FM" =
"TX-B FAULT", goto line 13

5

Lower "TX-B TO AIR" on site "BURK-FM" for [default]

6

Wait for 00:00:01

7

Turn macro "AUTO ON" on

8

End macro

9

Message "ATTEMPT XFER TO A"

10

If status of "TX-A FAULT / TX-A OK" on site "BURK-FM" =
"TX-A FAULT", goto line 13

11

Raise "TX-A TO AIR" on site "BURK-FM" for [default]

12

Goto line 6

13

Message "FAIL: TX FAULT”

14

Goto line 6

ANTENNA MONITOR
An older antenna monitor that has to be scanned for the phase and ratio readings can be read with a macro like
this. The antenna monitor phase and ratio are stored in separate channels for each tower. The values are held until
the next set of samples is taken. Tower strobes are set up as latches. The schedule for this macro is set for interval.
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1

Raise "TWR1 ON" on site "BURK-FM" for [default]

2

Wait for 00:00:05

3

Set 1 Phase on BURK-FM = MON PHASE on BURK-FM

4

Set 1 Ratio on BURK-FM = MON RATIO on BURK-FM

5

Lower "TWR1 OFF" on site "BURK-FM" for [default]

6

Raise "TWR2 ON" on site "BURK-FM" for [default]

7

Wait for 00:00:05

8

Set 2 Phase on BURK-FM = MON PHASE on BURK-FM

9

Set 2 Ratio on BURK-FM = MON RATIO on BURK-FM

10

Lower "TWR1 OFF" on site "BURK-FM" for [default]

11

End macro
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MACRO EXPRESSIONS
GENERAL
If

Set

The “If” macro command is a versatile way to compare two values in a macro. The types of values are: meter value, status
value, macro variable and constant. To use this command, select the type of value for each side of the equation using the
drop down lists, and pick the operator you want to use for comparison (=, <>, <, >).
The “Set” macro command allows you to set a meter channel, status channel or macro variable to any of the following:
meter channel, status channel, macro variable or constant. For example, if your antenna monitor readings appear on
channel 10, and you want to store the current reading on channel 11, you can set channel 11 to the value of channel 10.
Note: To set meter and status channels, you must first set the Source to Set by a macro in AutoLoad PLus.

ARC PLUS
Expressions in this section act on or receive data from the ARC Plus.
If Value
If Status
If New Value
If New Status
If Relay State
If Alarm
If Maint Mode
Raise/Lower
Alarm
Set Mute
Set Limit

These statements test the expression against the most recently obtained meter/status value for the
specified site and channel.
This statement waits until the ARC Plus updates the meter/status reading before testing the
expression against the value. Use this macro function to test the result of a raise/lower command.
Tests if the state of a relay is latched or unlatched.
Tests the expression against the alarm count at the specified site. Can be used with an inequality to
trigger an action if the alarm count is greater than 0.
Tests the expression against the maintenance mode on/off state at the specified site.
Issues a command to the specified site and channel. Note that the command duration entered in
the macro editor will override the command duration otherwise programmed for the channel.
Generates an alarm on the ARC Plus with the specified message. Can also be used at the end of a
macro to initiate notification that the macro is complete.
Mutes alarm reporting on the specified channel.
Sets a meter channel limit value. This is typically used to change power limits on AM stations that
run with different day/night power.

DATE AND TIME
Date/time and day-of-week statements all reference the date/time or day-of-week as reported by the local ARC
Plus unit. For example, if you are programming a macro to execute a command at noon Eastern Time, but the ARC
Plus is configured to display Pacific Time, set the If Time statement to use 9:00AM.
If Date
If Time
If Day
If Calendar Time

Tests the expression based on the date and time at the site, or on the day of the week.
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MEMORY
Macros can manipulate up to 256 variables to perform a variety of functions. For example, a macro can increment
or decrement a variable, providing an event counter that can be read by a virtual channel. Note that a remote ARC
Plus cannot act upon a macro that resides on a different unit.
If Memory
Set Memory
Increment
Decrement

Tests the expression based on the value of the specified variable. The ARC Plus stores up to 256
variables, all of which can be acted on by any macro onboard the local ARC Plus.
Sets the variable to a specific value.
Increases or decreases the specified variable by one (1). Multiple increment or decrement
expressions can be combined to increase or decrease the variable by amounts greater than 1.

MACROS
Macros can be used to run and stop other macros, as well as use a particular macro’s running/stopped status in an
“if” statement.
If Macro
Set Macro

Tests the expression based on whether a macro is running (on) or stopped (off). A macro that is
scheduled to run, but is not currently executing instructions, is considered to be stopped.
Runs or stops the specified macro.

MISC

Wait
Message
Send Email
Email Report
Email Log
Speak Phrase
Goto Line
End

Programs the macro to pause for the specified duration before executing the next line of code.
Generates a new entry in the ARC Plus event log with the specified message text. Note that
messages do not initiate any email notification, but they can be logged and shown in reports.
Sends an email to the selected email list with the selected message.
Sends an email to the selected email list using a preconfigured email template. Click or turn to
EMAIL TEMPLATES for configuring the email template.
Sends an email to the selected email list with a text log of all current values on the system.
Used to output speech phrases through the RSI audio output jack. Instructs the RSI Plus to speak the
selected phrase.
Directs the macro to a specific line of code.
Stops the macro. The macro will run again when next scheduled, when called upon by another
macro, or when issued manually via the front panel, RSI, AutoPilot 2010 or web page.
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STARTING AND STOPPING MACROS
TOUCH SCREEN
There are many ways to configure macro start and stop, but the touch
screen on the ARC Plus Touch is always available for all macros with no
configuration required. See MACROS in the Operation section.

AUTOPILOT 2010
If you are using AutoPilot 2010, you can always start and stop macros from the
Macros list which is available from the menu bar as View>Macros or as keyboard
shortcut <F6>. See AutoPilot 2010 documentation for more details.
To start or stop a macro, select the desired macro and press the Run or Stop
buttons above the macro list. The current status of each macro will show to the
left of the macro name.

WEB PAGE
From the web page of the ARC Plus Touch, press the Macros tab. All macros are
available here and can be started and stopped by pressing the Run or Stop
buttons.

RSI
During an RSI call, macros can be started or stopped by selecting the
desired macro then pressing * or #. Click or turn to RSI Command List
for details.
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RAISE AND LOWER BUTTONS
Using AutoLoad, raise and/or lower buttons on
any channel can be assigned to a macro start or
stop command. On the AutoPilot 2010
commands tab, hover over the source cell for
the desired channel and click on the […] button
to bring up the source dialog. For either button,
select Start Macro or Stop Macro from the
dropdown then select the macro you wish to start or stop. Often, you
will use a start macro for both raise and lower as shown here.

STATUS ACTIONS
A change in any status channel can be used to start or stop a macro. From the
AutoLoad Plus Status Actions tab, hover over On Action or Off Action of the
appropriate channel and press the […] button to open the Action dialog. Select
Run Macro or Stop Macro and select the desired macro in the Action target field.
Click or turn to STATUS ACTIONS for details.

FROM A MACRO
A macro that is running can include an instruction to start or stop
another macro. This is useful for chaining complicated sequences
and for reusing common sequences in different scenarios.
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MACRO SCHEDULE
The following start/stop methods can be set from the Macro
Schedule dialog box. On the macro editor, click on the cell next to
Schedule in the lower right hand corner, then click on the […]
button. This will bring up the dialog box.

ON DEMAND
This is the default and is the correct setting for all of the above methods.

AT STARTUP
When the ARC Plus Touch first powers on, a macro can be set to run. When the macro ends it will not run
again until the next power on, unless it is started manually. This is useful for automatically initializing a
system after a power failure. If the macro loops infinitely, it will always run unless it is stopped manually.
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INTERVAL
A macro can be scheduled to run at a scheduled interval such as every 15 seconds or once an hour. Click the
Run at an interval radio button and specify the number and units (seconds, minutes or hours).

TIME
To run at a specific time every day, choose the Schedule for a specific time radio button and enter the time.

CALENDAR TIME
This function allows a set of calendars in the ARC Plus Touch which are customized with times for each
month of the year to be used either in macro If statements or as a means to start macros. Choose the
Schedule for a calendar time radio button and select the appropriate calendar from the drop-down.

CONFIGURATION
Calendars and Email templates must be configured before use.

CALENDAR
Macros scheduled to run according to a calendar time reference the ARC Plus calendar, which is configured by
selecting Calendar from the Tools menu in the Macro Editor.

Note:
Calendars are labelled as
appropriate for some AM stations,
but they can also be used for
lighting control by entering the
monthly average sunrise and
sunset times for the site.

The Calendar allows six preset times of day, per month (Pre Sunrise, Sunrise, Sunset, Post Sunset, User 1 and User
2). Set up the schedule by clicking under the appropriate heading and using the arrows to set the desired time.
When a macro references one of these presets times, it will use the time-of-day configured here. Use standard
time when programming the calendar; the ARC Plus will automatically adjust for Daylight Saving Time if configured
to do so (Click or turn to TIME SETTINGS).
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EMAIL TEMPLATES
Macro email templates allow you to send customized email messages
containing site and channel data. To create or edit an email template, use
the Tools > Email Templates… menu item from the Macro Editor.

If you’ve used a mail merge
program, this will be easy.

The email template editor always shows all ten templates. To rename a template, select it in the list and then click
on its label to edit.
Click on the template name and the text, if any, will appear in the center pane. Use the built-in text editor to enter
the text for this template. The available tokens are displayed on the right of the screen. Type in the appropriate
token for the piece of information you wish to include. All characters that are not part of a token are treated
literally. For example, to send an email stating the value of channel 1 and the site name, use the following syntax:
%mLabel1 on %site = %m1%mUnits1 at %date %time
Assuming channel 1 is “Forward Pwr”, the email message will be similar to the following:
Forward Pwr on WXYZ = 2950W at 1/1/2012 9:15:00 AM
To send an email using a template, use the Email Report macro command. When that macro command is
triggered, the ARC Plus will use the selected template to send an email to the list specified in the macro command.
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CREATING MACROS
MACRO EDITOR

Edit>Settings>Macros…

Step by Step Instructions to Create a Macro
1
2
3
4
5
6

Macros are edited in AutoLoad Plus by selecting Macros… from the
Edit > Settings menu. This opens the Macro Editor.
Select an empty macro from the navigation pane on the left.
Click on the first line in the editor to select it for editing. A
dropdown box will appear right below the editor pane.
Click on the arrow in the drop-down box to see a list of commands.
Select the command for this line.
Make additional selections to complete the line, then press OK.

Note:
If you have Jet Active Flowcharts
installed, you can skip this
section and use the Jet editor in
AutoPilot 2010 to set up your
automatic functions.

As you create your macro, use the icons in the toolbar to cut/copy and paste
lines of code, delete lines, insert new lines, or reorder lines. When you insert new lines
inside of your macro, you will be prompted to update Go To references automatically.
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SAVING MACROS
MACRO NAME
Set a name for your macro by entering in the Name field in the macro properties list.

RUN LABEL AND STOP LABEL
While the touch screen macro menu displays the name of the macro, the command buttons used to run and
stop the macro can be programmed to display specific run and stop labels. By default, these labels are Run
Macro and Stop Macro. If desired, you can change these labels by entering text in the Run Label and Stop
Label fields in the macro properties list.

SPEECH LABEL
In order for an RSI speech interface to report the name of the macro, a label must be assigned in the Speech
Label field.

SCHEDULE
This field tells the macro when to run. Click or turn to MACRO SCHEDULE for details.
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